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Instant-Activity Kits
Classroom Suite includes 30 instant-activity kits. Each
kit includes an Activity ready for students to use, a
Template ready for teachers to create additional similar
activities quickly, and a PDF file of this tutorial.

Easy Writing
The Easy Writing instant-activity kit includes the Easy
Writing Fall activity, the Easy Writing Template, and a
PDF file of this tutorial. You can find these components
by opening the Language Arts Templates folder and
then the Easy Writing folder in the New area of
Classroom Suite.

The Easy Writing Template provides errorless writing
practice for students of all ages, including switch users.
Students use the provided sentence beginning and a
choice of sentence endings to create text about a topic
or theme. The text is read aloud by the computer as
students make selections. Three story starters (Spring
is, Winter is, and I like) are ready for you to add
customized sentence endings. You will also learn how
to create your own topic for a story.

In this tutorial, you will start by exploring the Easy
Writing Fall activity. Later in the tutorial, you will learn
to create customized writing activities, using the Easy
Writing template.

Universal Design
The activities you create using the Easy Writing
Template and Classroom Suite are designed for all
students, including those with physical or cognitive
disabilities. 
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Introduction

Create a Folder for Your New
Activities
When you use this template, you will be creating new
activities for your students to use. To organize these
activities, you will want to create your own folder in the
Activities area of Classroom Suite.

1. At the Navigation Screen, click the Activities
button. Click the New Folder button on the right
side of the screen. A dialog box will ask you to
name the folder. Give it the name of one of your
classes (e.g., Mrs. Smith’s Class).

2. Open the Easy Writing Template (see page 3).

3. When you complete your work with the template
and click the Finish Activity button, the Save As
Activity dialog box appears. Name your new
activity, select the folder in which you want to place
your work, and click OK. Your new activity will now
be available for you to assign to students.

This tutorial requires that you have installed
IntelliTalk 3. Authoring features necessary to

complete this tutorial are not available when using the
IntelliTalk 3 Player.

Note
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Part 1: Exploring the Easy Writing Fall Activity

Opening Easy Writing Fall
1. Sign in to Classroom Suite as a Teacher (see

Getting Started in the Classroom Suite binder). The
Navigation Screen displays.

2. Click the New button, if it is not already selected.

3. Open the Language Arts Templates folder.

4. Open the Easy Writing folder and choose Easy
Writing Fall. The Easy Writing Fall activity
displays.

Exploring Easy Writing Fall
This activity opens with a large blue button that writes
the beginning of a sentence on the page (Fall) and a
smaller Read All button that reads any text on the page
aloud.

1. Click the Fall button.

2. A new toolbar of picture buttons appears.

3. Click one of these picture buttons. Notice that the
sentence ending about fall is written and read
aloud. The toolbar then changes back to the
toolbar with the Fall button.

4. Click Fall again and then select a different
sentence ending.

5. Click the Read All button to hear all the text on the
page read aloud.

In the next part of this tutorial, you will learn to use the
Easy Writing Template to create additional errorless
writing activities for your students.

Easy Writing Football, in the Sports Mania
Thematic Unit, is a ready-to-use activity like

Easy Writing Fall, using the theme of Sports.
Note



The Easy Writing Template provides errorless writing
practice for students of all ages, including switch users.
Three story starters (Spring is, Winter is, and I like)
are ready for you to add customized sentence endings.
Later in this tutorial, you will learn how to use the
Begin Sentence button to create your own topic for a
story.

Opening the Easy Writing Template
1. From the Navigation Screen, click the New button.

2. Open the Language Arts Templates folder.

3. Open the Easy Writing folder and choose the Easy
Writing Template.

Selecting a Story
1. The first page of the template displays. The page is

filled with a yellow text box containing information
about the template. There is a toolbar on the right
side of the screen.

2. Click one of the blue story starter buttons in the
toolbar at the right. For this example, choose
Winter is.

3. The opening page of the Winter is activity displays.
It has authoring instructions at the top of the page
and a toolbar with the sentence beginning “Winter
is” at the left and the Read All button at the right.

4. If you want to change your selection, click the
green Start Over button on the right. This will
enable you to make another choice.

5. See the instructions on page 1 of this tutorial to
learn how to create a special folder to store the new
activities you make with this and other templates in
Classroom Suite.

6. From the File menu, select Save As Activity. Save
your activity with a unique name, such as Easy
Writing Winter. It will now be saved into the
Activities folder.

In the next part of the tutorial, you will
customize the word bank buttons so students

can write sentences about winter.
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Part 2: Using the Easy Writing Template

Note
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Customizing the Sentence Endings
1. Click the blue Winter is button at the top of the

page.

2. A blue sentence ending toolbar displays at the top
of the page.

3. Simultaneously press the Control key on the
computer keyboard and click the first sentence
ending button: cold ([Ctrl]+click).

4. The Button Properties dialog box opens. Click the
Actions Tab.

Note the Button Actions window at the bottom
of the Actions dialog box. One of the actions is
Type Text “end of sentence.”

5. Select the action Type Text and then click Edit
from the buttons on the right. 

6. The Type Text dialog box displays. Type a
sentence ending about cold. For example, type:
cold that makes you shiver. Click OK twice to
return to the template.

Be sure that you put a period at the end of your
sentence ending. The period is necessary so

that the program will read the whole sentence
aloud.

7. Press the cold button and see your sentence
ending display on the screen and read aloud.

8. Repeat steps 3 through 6 for all the remaining
sentence ending buttons, writing a sentence ending
for each button that goes with the picture on that
button. 

Finishing the Activity
1. When you have finished creating sentence endings,

click the purple Finish Activity button at the right
of the page to save the activity for students to use.

2. Click Replace when prompted to replace the Easy
Writing Winter activity with this new version.

3. Close the activity 

Congratulations! You have just completed an easy
writing activity. You can assign this to your students
whenever you are ready.

In the next section of the tutorial, you will create your
own custom writing activity, if you wish to do so.

Part 2: Using the Easy Writing Template

Note

Note
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Creating Your Own Story
The Easy Writing Template can accommodate any
content that follows the pattern of adding a new ending
to a consistent sentence beginning. You can use this
template to create many different writing activities for
your students.

Beginning Your Sentence
1. Open the Easy Writing Template again. 

2. When the template displays, select the Begin
Sentence button from the toolbar at the right.

3. The opening page of the custom writing activity
displays. Authoring instructions display at the top
of the page. A blue Begin Sentence button is at the
upper left.

4. [Ctrl]+click the Begin Sentence button. The
Button Properties dialog box displays. 

5. Change the name of the button to a new sentence
beginning. For this example, type My body has in
the Button Name box.

6. Click the Insert Picture From Library button. From
the Category drop down list, select People. 

7. Select the picture of either Boy 5 or Girl 9 and click
Insert.

8. Click the Actions tab in the Button Properties
dialog box. 

9. In the Button Actions list box, select Type Text
action and click the Edit button. Change the text to
read: My body has and click OK.

10. From the File menu, select Save as Activity. Save
your document with a unique name, such as Easy
Writing My Body.

You have created the sentence beginning for your
custom writing activity.

Part 3: Customizing the Easy Writing Template
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Creating Sentence Endings
1, Click the My body has button you just created. A

toolbar displays with buttons named “picture of
ending.”

2. [Ctrl]+click the first sentence ending button. The
Button Properties dialog box displays.

3. Click the Insert Picture From Library button. From
the Category drop down list, select Body Parts. 

4. Select Arm and click Insert. 

5. Type arms in the Button Name box.

6. Click the Actions tab. Select the Type Text action
and click the Edit button. 

7. Type in the words you want to finish your
sentence. For this activity, type the phrase arms to
hold things. Be sure to end your phrase with a
period. Click OK.

8. Repeat steps 2 through 7, editing the rest of the
buttons to sentence endings for your new Easy
Writing activity.

9. When you have finished creating sentence endings,
click the purple Finish Activity button at the right
of the page to save the activity for students to use.
Click the Replace button to replace the activity with
this new version.

Congratulations! You have just customized the Easy
Writing Template with your own version. You can
assign this to your students whenever you are ready.

In the next section of the tutorial, you can customize
the template even further, if you wish to do so.
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Part 3: Customizing the Easy Writing Template



If you wish to customize the Easy Writing Template
even further, open the Easy Writing Template again,
or continue to customize the template you are
working on, using the following techniques.

Using Your Own Pictures and
Artwork
It is possible to add your own photos or pictures,
rather than using the pictures provided in this
program.

1. If it is not already open, open the Easy Writing
Template (see page 3).

2. [Ctrl]+click any one of the buttons you want to
change. The Button Properties dialog box
displays.

3. Click the Insert Picture from File button. Then
navigate to a picture you wish to use that you
have stored elsewhere on your computer, or on
another CD.

4. When you locate the picture you want, click OK.
The picture will display on the button you
selected.

5. Be sure to change the button name to match your
new picture.

Removing Buttons
If the Easy Writing activity is too long for some
students (i.e., it requires too many clicks to
complete), you can remove buttons for sentence
endings without affecting the function of the activity. 

1. With the template open, click the Begin Sentence
button. The End Sentence toolbar displays.

2. From the Edit menu, select Custom Toolbars and
Buttons. The Selected Toolbar and Selected
Button dialog boxes display.

3. Select the button you want to delete.

4. Click the trash can button in the Selected Button
dialog box to remove the button from the toolbar.

5. Repeat steps 3 and 4 for every button that you
wish to delete.

6. Click the Done button at the top right of the page
when you are finished.
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Part 3: Customizing the Easy Writing Template



Replacing Buttons
If you would like to add more sentence ending
buttons, or if you removed more buttons than you
intended to, it is easy to add them.

1. With the template open, click the Begin Sentence
button. The End Sentence toolbar displays.

2. From the Edit menu, select Custom Toolbars and
Buttons. The Selected Toolbar and Selected
Button dialog boxes display.

3. Select the End Sentence toolbar. From the
Selected Toolbar dialog, click Add Button. The
Add Button dialog box displays.

4. Select the Add From Open Document tab. A list of
all the buttons in this template displays.

5. Scroll down to the phrase “picture of ending,”
select it, and click Insert. The additional button
will insert at the end of the toolbar.

You can change the position of a button in a
toolbar by holding down the Shift key as you
drag the button to its new position.

Congratulations! You have learned many new ways to
customize an Easy Writing activity.
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Note

Part 3: Customizing the Easy Writing Template


